
Q .1Q .1 A cc ording to  the 2 0 1 1  cens us  of Ind ia ,  whic h of the fo l lowing S tates/ Union Terr itor ies  of  Ind ia  has  the highes t  s ex rat io?A cc ording to  the 2 0 1 1  cens us  of Ind ia ,  whic h of the fo l lowing S tates/ Union Terr itor ies  of  Ind ia  has  the highes t  s ex rat io?
A nsA ns 1. Puducherry

2. Tamil Nadu
3. Odisha
4. Kerala

Q .2Q .2 When was  the Prarthana S amaj es tabl is hed in Ind ia?When was  the Prarthana S amaj es tabl is hed in Ind ia?
A nsA ns 1. 1828

2. 1867
3. 1930
4. 1920

Q .3Q .3 A cc ording to  A rt ic le 66 of the Draft  C ons t itut ion of Ind ia ,  1 94 8,  what does  the Par l iament for  the Union c ons is t  of?A cc ording to  A rt ic le 66 of the Draft  C ons t itut ion of Ind ia ,  1 94 8,  what does  the Par l iament for  the Union c ons is t  of?
A nsA ns 1. The Prime Minister and one house

2. The Prime Minister and two houses
3. The President and two houses
4. The President and one house

Q .4Q .4 A t what proport ion do members  of the Rajy a S abha ret ire after  every  two y ears?A t what proport ion do members  of the Rajy a S abha ret ire after  every  two y ears?
A nsA ns 1. One-fourth

2. Two-fourth
3. One-third
4. Two-third

Q . 5Q . 5 Whic h of the fo l lowing organis at ions  s tarted the S huddhi  M ovement?Whic h of the fo l lowing organis at ions  s tarted the S huddhi  M ovement?
A nsA ns 1. 

2. 
3. 
4. 

Q .6Q .6 Whic h of the fo l lowing s tatements  bes t  des c r ibes  the 'eS hram – O ne S top S olut ion'  init iat ive,  launc hed by  the M inis try  of  L abourWhic h of the fo l lowing s tatements  bes t  des c r ibes  the 'eS hram – O ne S top S olut ion'  init iat ive,  launc hed by  the M inis try  of  L abour
& E mploy ment?& E mploy ment?

A nsA ns 1. An online job portal exclusively for government job seekers
2. A centralised portal integrating multiple welfare schemes for unorganised workers
3. A digital platform for formal sector employees to access employment benefits
4. A financial literacy program for rural entrepreneurs

Q .7Q .7 Whic h of the fo l lowing is  NO T a ty pe of jur is d ic t ion of the S upreme C ourt  of  Ind ia?Whic h of the fo l lowing is  NO T a ty pe of jur is d ic t ion of the S upreme C ourt  of  Ind ia?
A nsA ns 1. Original Jurisdiction

2. Appellate Jurisdiction
3. Extensive Jurisdiction
4. Advisory Jurisdiction

Q .8Q .8 In whic h s tate are the Khetr i  c opper  mines  loc ated?In whic h s tate are the Khetr i  c opper  mines  loc ated?
A nsA ns 1. Rajasthan

2. Odisha
3. Jharkhand
4. Karnataka
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Q .9Q .9 In February  2 0 24 ,  the 7In February  2 0 24 ,  the 7t ht h  ed it ion of the Indian O cean C onference was  held  in whic h c ountry ? edit ion of the Indian O cean C onference was  held  in whic h c ountry ?

A nsA ns 1. Bangladesh
2. Thailand
3. Indonesia
4. Australia

Q .1 0Q .1 0 Who was  the firs t  trans lator  of  The C ommunis t  M anifes to  into  Bengal i?Who was  the firs t  trans lator  of  The C ommunis t  M anifes to  into  Bengal i?
A nsA ns 1. Mirza Ghulam Ahmed

2. Saumyendranath Tagore
3. N Dutta Mazumder
4. Kazi Nazrul Islam

Q .1 1Q .1 1 Whic h internat ional  body  launc hed the V ic t ims  of Terror is m A dvoc ac y  Network  ( VoTA N)  on 2 8 A pr i l  2 0 2 5,  to  s upport  ind iv idualsWhic h internat ional  body  launc hed the V ic t ims  of Terror is m A dvoc ac y  Network  ( VoTA N)  on 2 8 A pr i l  2 0 2 5,  to  s upport  ind iv iduals
and c ommunit ies  affec ted by  ac ts  of  terror is m?and c ommunit ies  affec ted by  ac ts  of  terror is m?

A nsA ns 1. United Nations Security Council
2. United Nations Human Rights Council (UNHRC)
3. International Criminal Court (ICC)
4. United Nations Office of Counter-Terrorism (UNOCT)

Q .1 2Q .1 2 The G ir  Fores t  of  G ujarat  s tate is  famous  for  __________ .The G ir  Fores t  of  G ujarat  s tate is  famous  for  __________ .
A nsA ns 1. lion-tailed macaques

2. the one-horned rhino
3. crocodiles
4. the Asiatic lion

Q .1 3Q .1 3 A s  per  the C ens us  of Ind ia  2 0 1 1 ,  in whic h rel igion was  the highes t  populat ion growth rate rec orded?A s  per  the C ens us  of Ind ia  2 0 1 1 ,  in whic h rel igion was  the highes t  populat ion growth rate rec orded?
A nsA ns 1. Christianity

2. Sikhism
3. Hinduism
4. Islam

Q .1 4Q .1 4 Whic h c ity  offic ial ly  proc la imed 1 4  A pr i l  2 0 2 5 as  Dr.  BR A mbedkar  Day  to  honour  the legac y  of the Indian s oc ia l  reformer andWhic h c ity  offic ial ly  proc la imed 1 4  A pr i l  2 0 2 5 as  Dr.  BR A mbedkar  Day  to  honour  the legac y  of the Indian s oc ia l  reformer and
arc hitec t  of  the C ons t itut ion?arc hitec t  of  the C ons t itut ion?

A nsA ns 1. New York City
2. Toronto
3. Washington DC
4. London

Q .1 5Q .1 5 Who among the fo l lowing defeated the k ing of V i jay anagar  and annexed G olc onda to  the Bahamani  k ingdom?Who among the fo l lowing defeated the k ing of V i jay anagar  and annexed G olc onda to  the Bahamani  k ingdom?
A nsA ns 1. Humayun Shah

2. Mahmud Gawan
3. Muhammad I
4. Bahman Shah

Q .1 6Q .1 6 A cc ording to  the National  Bureau of S o i l  S urvey  and L and Us e P lanning-2 0 1 3,  whic h of the fo l lowing is  the main c aus e of landA cc ording to  the National  Bureau of S o i l  S urvey  and L and Us e P lanning-2 0 1 3,  whic h of the fo l lowing is  the main c aus e of land
degradation in Punjab?degradation in Punjab?

A nsA ns 1. Overgrazing
2. Extensive cultivation
3. Deforestation
4. Over-irrigation

Q .1 7Q .1 7 Who among the fo l lowing launc hed the 'S c ience for  Women- A  Tec hnology  & Innovat ion ( S WATI) '  Portal  in February  2 0 24 ?Who among the fo l lowing launc hed the 'S c ience for  Women- A  Tec hnology  & Innovat ion ( S WATI) '  Portal  in February  2 0 24 ?
A nsA ns 1. Amitabh Kant

2. Prof. Govindarajan Padmanabhan
3. Suman Bery
4. Prof. Ajay Kumar Sood
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Q .1 8Q .1 8 In whic h per iod d id  the las t  effec t ive M ughal  emperor  named A urangzeb rule Ind ia?In whic h per iod d id  the las t  effec t ive M ughal  emperor  named A urangzeb rule Ind ia?
A nsA ns 1. 1658 - 1707

2. 1707 - 1760
3. 1627 - 1658
4. 1605 - 1627

Q .1 9Q .1 9 Whic h pres t igious  t it le d id  Ind ian G randmas ter  R Praggnanandhaa win at  the S uperbet C las s ic ,  2 0 2 5,  in Romania?Whic h pres t igious  t it le d id  Ind ian G randmas ter  R Praggnanandhaa win at  the S uperbet C las s ic ,  2 0 2 5,  in Romania?
A nsA ns 1. World Rapid Chess Championship

2. Grand Chess Tour Title
3. FIDE Candidates Tournament
4. Tata Steel Chess Masters

Q .2 0Q .2 0 Before as s uming office,  every  judge of the S upreme C ourt  takes  an oath in the form pres c r ibed in the ________ S c hedule of theBefore as s uming office,  every  judge of the S upreme C ourt  takes  an oath in the form pres c r ibed in the ________ S c hedule of the
C ons t itut ion.C ons t itut ion.

A nsA ns 1. 2nd

2. 1st

3. 4th

4. 3rd

Q .2 1Q .2 1 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  
( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .
E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  andE .g .  1 3  – O perat ions  on 1 3  s uc h as  adding /  s ubtrac t ing /mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and
then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  then performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  

( 5,1 7,2 7)( 5,1 7,2 7)
( 7,1 5,2 9)( 7,1 5,2 9)

A nsA ns 1. (23,11,53)
2. (27,3,57)
3. (19,13,39)
4. (11,12,50)

Q .2 2Q .2 2 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 6  1 6  2 0  2 0  2 5 2 5 3 1  3 1  3 8 3 8 ??
A nsA ns 1. 46

2. 45
3. 47
4. 44

Q .2 3Q .2 3 E ac h of the d igits  in the number 873 54 1 2  is  arranged in as cending order  from left  to  r ight .  The pos it ion(s)  of  how many  d igits  wi l lE ac h of the d igits  in the number 873 54 1 2  is  arranged in as cending order  from left  to  r ight .  The pos it ion(s)  of  how many  d igits  wi l l
remain unc hanged as  c ompared to  that  in the or iginal  number?remain unc hanged as  c ompared to  that  in the or iginal  number?

A nsA ns 1. One
2. Three
3. None
4. Two

Section : Logical Reasoning
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Q .24Q .24 A  paper  is  fo lded and c ut  as  s hown below.  How wi l l  i t  appear  when unfolded?A  paper  is  fo lded and c ut  as  s hown below.  How wi l l  i t  appear  when unfolded?

A nsA ns 1. 

2. 

3. 

4. 

Q .2 5Q .2 5 DA NC E  is  related to  JG TIK in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  C HO S E N is  related to  INUYKT.DA NC E  is  related to  JG TIK in a  certain way  bas ed on the E ngl is h a lphabetic al  order.  In the s ame way ,  C HO S E N is  related to  INUYKT.
To whic h of the given options  is  A C TIO N related ,  fo l lowing the s ame logic ?  To whic h of the given options  is  A C TIO N related ,  fo l lowing the s ame logic ?  

A nsA ns 1. 
2. 
3. 
4. 

Q .2 6Q .2 6 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l l  numbers  are s ingle- d igit  numbers  only . )Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l l  numbers  are s ingle- d igit  numbers  only . )
( L eft)  5 7  9  5 3  2  1  3  4  8  6  4  2  7  9  8  1  4  6  8  2  3  5 9  4  ( Right)( L eft)  5 7  9  5 3  2  1  3  4  8  6  4  2  7  9  8  1  4  6  8  2  3  5 9  4  ( Right)
How many  s uc h odd d igits  are there,  eac h of whic h is  immediately  preceded by  an odd d igit  and als o  immediately  fo l lowed by  anHow many  s uc h odd d igits  are there,  eac h of whic h is  immediately  preceded by  an odd d igit  and als o  immediately  fo l lowed by  an
even d igit?  (C ounting to  be done from left  to  r ight  only . )even d igit?  (C ounting to  be done from left  to  r ight  only . )

A nsA ns 1. One
2. Four
3. Three
4. Two

Q .2 7Q .2 7 Refer  to  the fo l lowing s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .Refer  to  the fo l lowing s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .

( L eft)  T  ( L eft)  T  X  X  R R E  E  N N H H O  O  F F E  E  J  J  F  F N N X X  I  I  E  E  A  A  O  O  U ( Right)U ( Right)

Whic h letter  is  third  to  the r ight  of the s ixth letter  from the left  end in the given s er ies?Whic h letter  is  third  to  the r ight  of the s ixth letter  from the left  end in the given s er ies?
A nsA ns 1. U

2. E
3. N
4. F

Q .2 8Q .2 8 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and thus  form aBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ters  are a l ike in a  certain way  and thus  form a
group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  group.  Whic h letter- c lus ter  DO E S  NO T belong to  that  group?  
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. LPK
2. NRO
3. JNI
4. HLG
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Q .2 9Q .2 9 What wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’ and ‘× ‘  are interc hanged and ‘−’ and ‘÷ ’ areWhat wi l l  c ome in place of the ques t ion mark  ( ? )  in the fo l lowing equation if  ‘+ ’ and ‘× ‘  are interc hanged and ‘−’ and ‘÷ ’ are
interc hanged?interc hanged?
4  ×  1 4  + 7  ÷  4 2  − 6  = ?4  ×  1 4  + 7  ÷  4 2  − 6  = ?

A nsA ns 1. 90
2. 85
3. 95
4. 100

Q .3 0Q .3 0 How many  s uc h pairs  of  letters  are there in the word PHYS IC A L  (when c ounted forward i . e . ,  in  the order  A - Z and bac kward i . e . ,  Z- A)How many  s uc h pairs  of  letters  are there in the word PHYS IC A L  (when c ounted forward i . e . ,  in  the order  A - Z and bac kward i . e . ,  Z- A)
whic h have as  many  letters  between them in the word as  there are in the E ngl is h a lphabetic al  order?whic h have as  many  letters  between them in the word as  there are in the E ngl is h a lphabetic al  order?

A nsA ns 1. One
2. Three
3. Two
4. Zero

Q .3 1Q .3 1 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to  be done from left  to  r ight  only .
( L eft)  E  M  O  Z I  D  W A  U S  L  F P  B  Y  J  T  N R G  V  H C  X  ( Right)( L eft)  E  M  O  Z I  D  W A  U S  L  F P  B  Y  J  T  N R G  V  H C  X  ( Right)
How many  letters  are there in the s er ies  between the firs t  vowel  from the left  and the firs t  vowel  from the r ight?How many  letters  are there in the s er ies  between the firs t  vowel  from the left  and the firs t  vowel  from the r ight?

A nsA ns 1. Three
2. Seven
3. Four
4. Ten

Q .3 2Q .3 2 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ter  pairs  are a l ike in a  certain way  and thus  form aBas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter- c lus ter  pairs  are a l ike in a  certain way  and thus  form a
group.  Whic h letter- c lus ter  pair  DO E S  NO T belong to  that  group?  group.  Whic h letter- c lus ter  pair  DO E S  NO T belong to  that  group?  
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their  pos it ion in the letter- c lus ter. )

A nsA ns 1. AC-DF
2. LN-OQ
3. MO-PS
4. GI-JL

Q .3 3Q .3 3 If  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 1 853 674 ,  what wi l l  be the s um of the d igitsIf  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the number 1 853 674 ,  what wi l l  be the s um of the d igits
that  are s ec ond from the left  and s ec ond from the r ight  in the new number thus  formed?that are s ec ond from the left  and s ec ond from the r ight  in the new number thus  formed?

A nsA ns 1. 11
2. 12
3. 14
4. 10

Q .3 4Q .3 4 Five pers ons ,  L ,  M ,  N,  O,  and P  are s itt ing in a  row,  fac ing the north.  P  is  s itt ing 3Five pers ons ,  L ,  M ,  N,  O,  and P  are s itt ing in a  row,  fac ing the north.  P  is  s itt ing 3r dr d  from the left  end of the row.  L  is  s itt ing at  one from the left  end of the row.  L  is  s itt ing at  one
of the ends .  M  s its  third  to  the r ight  of L .  O  is  not  an immediate neighbour  of L .of  the ends .  M  s its  third  to  the r ight  of L .  O  is  not  an immediate neighbour  of L .
Who s its  at  the extreme r ight end of the row?Who s its  at  the extreme r ight end of the row?

A nsA ns 1. N
2. L
3. M
4. O
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Q .3 5Q .3 5 In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain mathematic al  operat ions  to  the firs t  number.In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain mathematic al  operat ions  to  the firs t  number.
Whic h numbers  s hould  replace X  and Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide of : :  is  s ame as  that  onWhic h numbers  s hould  replace X  and Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide of : :  is  s ame as  that  on
the r ight  s ide of : :  ?the r ight  s ide of : :  ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing down the numbers  into  their  c ons t ituent d igits .
E .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and thenE .g .  1 3  – O perat ions  on 1 3  s uc h as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3  into  1  and 3  and then
performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  performing mathematic al  operat ions  on 1  and 3  is  not  a l lowed . )  

X  :  57  : :  24  :  YX :  57  : :  24  :  Y
A nsA ns 1. X = 13 , Y = 167

2. X = 12 , Y = 166
3. X = 11 , Y = 122
4. X = 12 , Y = 169

Q .3 6Q .3 6 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

2 1 7  2 1 7  2 2 0  2 2 0  2 2 5 2 2 5 2 3 2  2 3 2  24 1  24 1  ??
A nsA ns 1. 267

2. 260
3. 252
4. 264

Q .3 7Q .3 7 In a  certain c ode language,In a  certain c ode language,
‘A  + B ’ means  ‘A  is  the daughter  of B ’‘A  + B ’ means  ‘A  is  the daughter  of B ’
‘A  – B ’ means  ‘A  is  the brother  of B ’‘A  – B ’ means  ‘A  is  the brother  of B ’
‘A  x  B ’ means  ‘A  is  the wife of B ’‘A  x  B ’ means  ‘A  is  the wife of B ’
‘A  # B ’ means  ‘A  is  the father  of B ’‘A  # B ’ means  ‘A  is  the father  of B ’

Bas ed on the above,  how is  H  related to  I  i f  ‘H  – E  + R x  O  # I ’?Bas ed on the above,  how is  H  related to  I  i f  ‘H  – E  + R x  O  # I ’?
A nsA ns 1. Son

2. Husband
3. Father
4. Brother

Q .3 8Q .3 8 S ix  boxes ,  A ,  B,  C ,  D,  E ,  and F,  are kept one over  the other  but not  neces s ar i ly  in the s ame order.  E  is  kept s ec ond from the bottom.S ix  boxes ,  A ,  B,  C ,  D,  E ,  and F,  are kept one over  the other  but not  neces s ar i ly  in the s ame order.  E  is  kept s ec ond from the bottom.
O nly  one box is  kept between F and B.  O nly  three boxes  are kept between E  and D.  A  is  kept immediately  below E .  C  is  keptO nly  one box is  kept between F and B.  O nly  three boxes  are kept between E  and D.  A  is  kept immediately  below E .  C  is  kept
immediately  above B.  Whic h box is  s ec ond from the top?immediately  above B.  Whic h box is  s ec ond from the top?

A nsA ns 1. B
2. D
3. F
4. C

Q .3 9Q .3 9 S elec t  the s et  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets  given below.  Both s ets  fo l low the s ame pattern.S elec t  the s et  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets  given below.  Both s ets  fo l low the s ame pattern.

NS  – PU – RWNS  – PU – RW
DI – FK – HMDI – FK – HM

A nsA ns 1. GL – IN – KP
2. GL – IM – KP
3. HM – IM – KP
4. HM – IN – LP

Q .4 0Q .4 0 DF 1 0  is  related to  IK 2 0  in a  certain way .  In the s ame way ,  M O  1 7  is  related to  RT 2 7.  To  whic h of the given options  is  L N 4 6DF 1 0  is  related to  IK 2 0  in a  certain way .  In the s ame way ,  M O  1 7  is  related to  RT 2 7.  To  whic h of the given options  is  L N 4 6
related ,  fo l lowing the s ame logic ?related ,  fo l lowing the s ame logic ?

A nsA ns 1. QS 51
2. RT 51
3. QS 56
4. SU 56

Section : General English and Comprehension
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Q .4 1Q .4 1 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

S he c r ied  _________ for  help when s he s aw the danger.S he c r ied  _________ for  help when s he s aw the danger.
A nsA ns 1. boldly

2. frantically
3. gradually
4. urgently

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

The weather  in the mountains  c an be ____ unpredic table.The weather  in the mountains  c an be ____ unpredic table.
A nsA ns 1. too

2. fairly
3. rather
4. much

Q .43Q .43 S elec t  the mos t appropr iate option that  c an s ubs t itute the under l ined word in the given s entence.S elec t  the mos t appropr iate option that  c an s ubs t itute the under l ined word in the given s entence.
The dec is ion was  met with The dec is ion was  met with wides preadwides pread  approval  from the c ommunity . approval  from the c ommunity .

A nsA ns 1. silent
2. limited
3. temporary
4. general

Q .4 4Q .4 4 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

To make a long s tory  s hortTo make a long s tory  s hort
A nsA ns 1. To change the topic

2. To tell a very detailed account
3. To interrupt someone frequently
4. To summarise briefly

Q .4 5Q .4 5 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group of words .

A  s tate or  feel ing of great  unhappines s  or  s uffer ingA  s tate or  feel ing of great  unhappines s  or  s uffer ing
A nsA ns 1. Contentment

2. Bliss
3. Joy
4. Misery

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.
Over the past decade, e-learning has transformed the way students and professionals acquire knowledge. With internet access becoming
widespread, learning is no longer confined to physical classrooms. Digital platforms now offer interactive courses, recorded lectures and
personalised feedback, making education more accessible and flexible. Students in remote areas can attend classes from top institutions, while
working professionals can upskill without leaving their jobs. E-learning also supports a variety of learning styles—visual, auditory and kinesthetic
—allowing learners to progress at their own pace. However, the shift to online education also presents challenges, such as screen fatigue, limited
peer interaction and the need for self-discipline. Despite these drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As technology continues to evolve, e-learning is poised to play an
even greater role in the future of education.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 Whic h of the fo l lowing bes t  s ummaris es  the pas s age?Whic h of the fo l lowing bes t  s ummaris es  the pas s age?
A nsA ns 1. Online education is a temporary trend.

2. E-learning is harmful due to screen time and loneliness.
3. E-learning helps make education accessible despite some challenges.
4. Technology has no place in classrooms.
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.
Over the past decade, e-learning has transformed the way students and professionals acquire knowledge. With internet access becoming
widespread, learning is no longer confined to physical classrooms. Digital platforms now offer interactive courses, recorded lectures and
personalised feedback, making education more accessible and flexible. Students in remote areas can attend classes from top institutions, while
working professionals can upskill without leaving their jobs. E-learning also supports a variety of learning styles—visual, auditory and kinesthetic
—allowing learners to progress at their own pace. However, the shift to online education also presents challenges, such as screen fatigue, limited
peer interaction and the need for self-discipline. Despite these drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As technology continues to evolve, e-learning is poised to play an
even greater role in the future of education.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 How is  the pas s age s truc tured?How is  the pas s age s truc tured?
A nsA ns 1. Timeline of internet history

2. General-to-specific with examples and consequences
3. Personal story of an online learner
4. Dialogue between teacher and student

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.
Over the past decade, e-learning has transformed the way students and professionals acquire knowledge. With internet access becoming
widespread, learning is no longer confined to physical classrooms. Digital platforms now offer interactive courses, recorded lectures and
personalised feedback, making education more accessible and flexible. Students in remote areas can attend classes from top institutions, while
working professionals can upskill without leaving their jobs. E-learning also supports a variety of learning styles—visual, auditory and kinesthetic
—allowing learners to progress at their own pace. However, the shift to online education also presents challenges, such as screen fatigue, limited
peer interaction and the need for self-discipline. Despite these drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As technology continues to evolve, e-learning is poised to play an
even greater role in the future of education.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 What is  the central  theme of the pas s age?What is  the central  theme of the pas s age?
A nsA ns 1. Online courses are easier than in-person classes.

2. E-learning is replacing traditional education.
3. Internet has become more affordable.
4. E-learning is transforming access to education.

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.
Over the past decade, e-learning has transformed the way students and professionals acquire knowledge. With internet access becoming
widespread, learning is no longer confined to physical classrooms. Digital platforms now offer interactive courses, recorded lectures and
personalised feedback, making education more accessible and flexible. Students in remote areas can attend classes from top institutions, while
working professionals can upskill without leaving their jobs. E-learning also supports a variety of learning styles—visual, auditory and kinesthetic
—allowing learners to progress at their own pace. However, the shift to online education also presents challenges, such as screen fatigue, limited
peer interaction and the need for self-discipline. Despite these drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As technology continues to evolve, e-learning is poised to play an
even greater role in the future of education.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 What is  the mos t appropr iate t it le for  the pas s age?What is  the mos t appropr iate t it le for  the pas s age?
A nsA ns 1. The Rise of E-Learning

2. Benefits and Challenges of E-Learning
3. The End of Traditional Schools
4. Online Gaming and Education
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.
Over the past decade, e-learning has transformed the way students and professionals acquire knowledge. With internet access becoming
widespread, learning is no longer confined to physical classrooms. Digital platforms now offer interactive courses, recorded lectures and
personalised feedback, making education more accessible and flexible. Students in remote areas can attend classes from top institutions, while
working professionals can upskill without leaving their jobs. E-learning also supports a variety of learning styles—visual, auditory and kinesthetic
—allowing learners to progress at their own pace. However, the shift to online education also presents challenges, such as screen fatigue, limited
peer interaction and the need for self-discipline. Despite these drawbacks, the benefits of e-learning are significant. It promotes lifelong learning
and democratises education by removing geographical and financial barriers. As technology continues to evolve, e-learning is poised to play an
even greater role in the future of education.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 What is  the tone of the pas s age?What is  the tone of the pas s age?
A nsA ns 1. Critical and harsh

2. Balanced and informative
3. Humorous and playful
4. Disappointed and negative

Q . 51Q . 51 ‘‘ YपाYपा ’ ’ काका   प य^ यवा चीप य^ यवा ची   शcशc   हैहै ??
A nsA ns 1. करg

2. hवभावरg
3. धरा
4. पय

Q . 52Q . 52 '' भा ड़भा ड़   झm क नाझm क ना '  '  मुहा वरामुहा वरा   काका   सहीसही   अथtअथt   हो गाहो गा  - -
A nsA ns 1. wथt मx समय wतीत करना

2. संघषt मx जीवन wतीत करना
3. साथtक कायt को संपा~दत करना
4. क~ठन प�र�म करना

Q . 53Q . 53 '' आ का शआ का श   कु सुमकु सुम   हो नाहो ना '  '  काका   अथtअथt   हैहै --
A nsA ns 1. नीला होना

2. सुंदर होना
3. दूर होना
4. पहंुच से बाहर होना

Q . 54Q . 54 उ �चतउ �चत   का र कका र क   �च�m�च�m   काका   � यो ग� यो ग   क र तेक र ते   हुएहुए   वा �वा �   प ूणtप ूणt   क रxक रx --
रा मरा म  - - - -   - - - -  रो टीरो टी   खा ईखा ई  । ।

A nsA ns 1. का
2. ने
3. मx
4. पर

Q . 55Q . 55 '' उ प भु�उ प भु� '  '  काका   hवलो मhवलो म   शcशc   हो गाहो गा  - -
A nsA ns 1. अनु�ीणt

2. अनुपभु�
3. अनुपयु�
4. दु�पयोग
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C omprehens ion:C omprehens ion:
~दए गए ग��◌ंश के आधार पर hन��िकत ��m के उ�र दी�जए-- 
भाषा के Yे�ीय �प को बोली कहा जाता है। भारत मx अनेक बो�लय� ह । ये बो�लय� भाषा के hवकास मx कारगर काम करती ह । इन बो�लयm से मानक भाषा का शc भंडार समृ¤ होता है।
~हदंी भी एक ऐसी ही भाषा है। �जसमx उसक¦ Yे�ीय बो�लयm के शc �चुर मा�ा मx �योग होते ह । �जस �कार भारत मx भाषाई hवhवधता है, उसी �कार यह� पर स�§ृhतक hवhवधता भी
hव�मान है। भाषाई hवhवधता का अथt है – एक भौगो�लक Yे� मx अनेक भाषाओं का सह-अª«¬। भारत मx यह hवhवधता भाषा, उपभाषा, �लिप, उ­ारण और शैली के «र पर भी देखी
जाती है। भारत मx 19,500 से अ¯धक भाषाएँ और बो�लय� पाई जाती ह । इनमx से लगभग 121 भाषाओं को बड़े  «र पर बोला जाता है। भारत मx hवhवधता इसक¦ सबसे अनूठ± और hवशेष
पहचान है। यह hवhवधता केवल भाषा तक सीhमत नह² है, ब³´ धमt, जाhत, सं§ृhत, खानपान, पहनावा, परंपराएँ, µोहार, भूगोल और जीवनशैली तक फैली हुई है। यह� अनेक जाhत, धमt
और Yे� के लोग hनवास करते ह । भारत मx सभी धम· के µोहार, पूजा-प¤hत, और धाhमtक ¸ल hमलते ह – जैसे िक मं~दर, म¹ºद, चचt, गु�»ारे आ~द। भारत का भूगोल भी hवhवधता से
भरपूर है– उ�र मx ~हमालय, द�Yण मx समु¼, प�½म मx रे ¾ग«ान, और पूवt मx घने जंगल। हर Yे� का अपना पहनावा, खानपान और लोककलाएं ह । लेिकन िफर भी हमारg रा¿À ीय एकता
अÁÂ और मजबूत है। यह केवल एक नारा ही नह² है ब³´ भारतीय जीवन दशtन का मूल है। यह केवल स�§ृhतक hवशेषता नह², ब³´ एक ऐसी hवरासत है �जसे पीढ़g दर पीढ़g आगे
बढ़ाया गया है। 'hवhवधता मx एकता' का भाव हमx �सखाता है िक मतभेद होने के बावजूद हम hमलकर रह सकते ह । भारत इस�लए महान है �mिक यह� हर ¯भÄता मx भी अपनापन है ।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 भा षाभा षा   केके   Yे�ी यYे�ी य   � प� प   कोको   �ा�ा   क हाक हा   जा ताजा ता   हैहै ??
A nsA ns 1. भाषा

2. Yे�ीय भाषा
3. मानस भाषा
4. बोली

C omprehens ion:C omprehens ion:
~दए गए ग��◌ंश के आधार पर hन��िकत ��m के उ�र दी�जए-- 
भाषा के Yे�ीय �प को बोली कहा जाता है। भारत मx अनेक बो�लय� ह । ये बो�लय� भाषा के hवकास मx कारगर काम करती ह । इन बो�लयm से मानक भाषा का शc भंडार समृ¤ होता है।
~हदंी भी एक ऐसी ही भाषा है। �जसमx उसक¦ Yे�ीय बो�लयm के शc �चुर मा�ा मx �योग होते ह । �जस �कार भारत मx भाषाई hवhवधता है, उसी �कार यह� पर स�§ृhतक hवhवधता भी
hव�मान है। भाषाई hवhवधता का अथt है – एक भौगो�लक Yे� मx अनेक भाषाओं का सह-अª«¬। भारत मx यह hवhवधता भाषा, उपभाषा, �लिप, उ­ारण और शैली के «र पर भी देखी
जाती है। भारत मx 19,500 से अ¯धक भाषाएँ और बो�लय� पाई जाती ह । इनमx से लगभग 121 भाषाओं को बड़े  «र पर बोला जाता है। भारत मx hवhवधता इसक¦ सबसे अनूठ± और hवशेष
पहचान है। यह hवhवधता केवल भाषा तक सीhमत नह² है, ब³´ धमt, जाhत, सं§ृhत, खानपान, पहनावा, परंपराएँ, µोहार, भूगोल और जीवनशैली तक फैली हुई है। यह� अनेक जाhत, धमt
और Yे� के लोग hनवास करते ह । भारत मx सभी धम· के µोहार, पूजा-प¤hत, और धाhमtक ¸ल hमलते ह – जैसे िक मं~दर, म¹ºद, चचt, गु�»ारे आ~द। भारत का भूगोल भी hवhवधता से
भरपूर है– उ�र मx ~हमालय, द�Yण मx समु¼, प�½म मx रे ¾ग«ान, और पूवt मx घने जंगल। हर Yे� का अपना पहनावा, खानपान और लोककलाएं ह । लेिकन िफर भी हमारg रा¿À ीय एकता
अÁÂ और मजबूत है। यह केवल एक नारा ही नह² है ब³´ भारतीय जीवन दशtन का मूल है। यह केवल स�§ृhतक hवशेषता नह², ब³´ एक ऐसी hवरासत है �जसे पीढ़g दर पीढ़g आगे
बढ़ाया गया है। 'hवhवधता मx एकता' का भाव हमx �सखाता है िक मतभेद होने के बावजूद हम hमलकर रह सकते ह । भारत इस�लए महान है �mिक यह� हर ¯भÄता मx भी अपनापन है ।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 बो �लयmबो �लयm   काका   �ा�ा   मह¬मह¬   हैहै ??
A nsA ns 1. रा¿À ीय एकता के �लए

2. धाhमtक मह¬
3. शc भंडार समृÅ¤
4. राजनीhतक मह¬

C omprehens ion:C omprehens ion:
~दए गए ग��◌ंश के आधार पर hन��िकत ��m के उ�र दी�जए-- 
भाषा के Yे�ीय �प को बोली कहा जाता है। भारत मx अनेक बो�लय� ह । ये बो�लय� भाषा के hवकास मx कारगर काम करती ह । इन बो�लयm से मानक भाषा का शc भंडार समृ¤ होता है।
~हदंी भी एक ऐसी ही भाषा है। �जसमx उसक¦ Yे�ीय बो�लयm के शc �चुर मा�ा मx �योग होते ह । �जस �कार भारत मx भाषाई hवhवधता है, उसी �कार यह� पर स�§ृhतक hवhवधता भी
hव�मान है। भाषाई hवhवधता का अथt है – एक भौगो�लक Yे� मx अनेक भाषाओं का सह-अª«¬। भारत मx यह hवhवधता भाषा, उपभाषा, �लिप, उ­ारण और शैली के «र पर भी देखी
जाती है। भारत मx 19,500 से अ¯धक भाषाएँ और बो�लय� पाई जाती ह । इनमx से लगभग 121 भाषाओं को बड़े  «र पर बोला जाता है। भारत मx hवhवधता इसक¦ सबसे अनूठ± और hवशेष
पहचान है। यह hवhवधता केवल भाषा तक सीhमत नह² है, ब³´ धमt, जाhत, सं§ृhत, खानपान, पहनावा, परंपराएँ, µोहार, भूगोल और जीवनशैली तक फैली हुई है। यह� अनेक जाhत, धमt
और Yे� के लोग hनवास करते ह । भारत मx सभी धम· के µोहार, पूजा-प¤hत, और धाhमtक ¸ल hमलते ह – जैसे िक मं~दर, म¹ºद, चचt, गु�»ारे आ~द। भारत का भूगोल भी hवhवधता से
भरपूर है– उ�र मx ~हमालय, द�Yण मx समु¼, प�½म मx रे ¾ग«ान, और पूवt मx घने जंगल। हर Yे� का अपना पहनावा, खानपान और लोककलाएं ह । लेिकन िफर भी हमारg रा¿À ीय एकता
अÁÂ और मजबूत है। यह केवल एक नारा ही नह² है ब³´ भारतीय जीवन दशtन का मूल है। यह केवल स�§ृhतक hवशेषता नह², ब³´ एक ऐसी hवरासत है �जसे पीढ़g दर पीढ़g आगे
बढ़ाया गया है। 'hवhवधता मx एकता' का भाव हमx �सखाता है िक मतभेद होने के बावजूद हम hमलकर रह सकते ह । भारत इस�लए महान है �mिक यह� हर ¯भÄता मx भी अपनापन है ।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 '' अÁÂअÁÂ ' '  शcशc   काका   अथtअथt   �ा�ा   हो ताहो ता   हैहै ??
A nsA ns 1. सारत¬

2. म�
3. शाÆत
4. छाजन

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


C omprehens ion:C omprehens ion:
~दए गए ग��◌ंश के आधार पर hन��िकत ��m के उ�र दी�जए-- 
भाषा के Yे�ीय �प को बोली कहा जाता है। भारत मx अनेक बो�लय� ह । ये बो�लय� भाषा के hवकास मx कारगर काम करती ह । इन बो�लयm से मानक भाषा का शc भंडार समृ¤ होता है।
~हदंी भी एक ऐसी ही भाषा है। �जसमx उसक¦ Yे�ीय बो�लयm के शc �चुर मा�ा मx �योग होते ह । �जस �कार भारत मx भाषाई hवhवधता है, उसी �कार यह� पर स�§ृhतक hवhवधता भी
hव�मान है। भाषाई hवhवधता का अथt है – एक भौगो�लक Yे� मx अनेक भाषाओं का सह-अª«¬। भारत मx यह hवhवधता भाषा, उपभाषा, �लिप, उ­ारण और शैली के «र पर भी देखी
जाती है। भारत मx 19,500 से अ¯धक भाषाएँ और बो�लय� पाई जाती ह । इनमx से लगभग 121 भाषाओं को बड़े  «र पर बोला जाता है। भारत मx hवhवधता इसक¦ सबसे अनूठ± और hवशेष
पहचान है। यह hवhवधता केवल भाषा तक सीhमत नह² है, ब³´ धमt, जाhत, सं§ृhत, खानपान, पहनावा, परंपराएँ, µोहार, भूगोल और जीवनशैली तक फैली हुई है। यह� अनेक जाhत, धमt
और Yे� के लोग hनवास करते ह । भारत मx सभी धम· के µोहार, पूजा-प¤hत, और धाhमtक ¸ल hमलते ह – जैसे िक मं~दर, म¹ºद, चचt, गु�»ारे आ~द। भारत का भूगोल भी hवhवधता से
भरपूर है– उ�र मx ~हमालय, द�Yण मx समु¼, प�½म मx रे ¾ग«ान, और पूवt मx घने जंगल। हर Yे� का अपना पहनावा, खानपान और लोककलाएं ह । लेिकन िफर भी हमारg रा¿À ीय एकता
अÁÂ और मजबूत है। यह केवल एक नारा ही नह² है ब³´ भारतीय जीवन दशtन का मूल है। यह केवल स�§ृhतक hवशेषता नह², ब³´ एक ऐसी hवरासत है �जसे पीढ़g दर पीढ़g आगे
बढ़ाया गया है। 'hवhवधता मx एकता' का भाव हमx �सखाता है िक मतभेद होने के बावजूद हम hमलकर रह सकते ह । भारत इस�लए महान है �mिक यह� हर ¯भÄता मx भी अपनापन है ।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 भा र तभा र त   क¦क¦   भा षा ईभा षा ई   ³¸ hत³¸ hत   �ा�ा   हैहै ??
A nsA ns 1. बहुभाषी

2. hवक�सत
3. समृ¤
4. भारतीय

C omprehens ion:C omprehens ion:
~दए गए ग��◌ंश के आधार पर hन��िकत ��m के उ�र दी�जए-- 
भाषा के Yे�ीय �प को बोली कहा जाता है। भारत मx अनेक बो�लय� ह । ये बो�लय� भाषा के hवकास मx कारगर काम करती ह । इन बो�लयm से मानक भाषा का शc भंडार समृ¤ होता है।
~हदंी भी एक ऐसी ही भाषा है। �जसमx उसक¦ Yे�ीय बो�लयm के शc �चुर मा�ा मx �योग होते ह । �जस �कार भारत मx भाषाई hवhवधता है, उसी �कार यह� पर स�§ृhतक hवhवधता भी
hव�मान है। भाषाई hवhवधता का अथt है – एक भौगो�लक Yे� मx अनेक भाषाओं का सह-अª«¬। भारत मx यह hवhवधता भाषा, उपभाषा, �लिप, उ­ारण और शैली के «र पर भी देखी
जाती है। भारत मx 19,500 से अ¯धक भाषाएँ और बो�लय� पाई जाती ह । इनमx से लगभग 121 भाषाओं को बड़े  «र पर बोला जाता है। भारत मx hवhवधता इसक¦ सबसे अनूठ± और hवशेष
पहचान है। यह hवhवधता केवल भाषा तक सीhमत नह² है, ब³´ धमt, जाhत, सं§ृhत, खानपान, पहनावा, परंपराएँ, µोहार, भूगोल और जीवनशैली तक फैली हुई है। यह� अनेक जाhत, धमt
और Yे� के लोग hनवास करते ह । भारत मx सभी धम· के µोहार, पूजा-प¤hत, और धाhमtक ¸ल hमलते ह – जैसे िक मं~दर, म¹ºद, चचt, गु�»ारे आ~द। भारत का भूगोल भी hवhवधता से
भरपूर है– उ�र मx ~हमालय, द�Yण मx समु¼, प�½म मx रे ¾ग«ान, और पूवt मx घने जंगल। हर Yे� का अपना पहनावा, खानपान और लोककलाएं ह । लेिकन िफर भी हमारg रा¿À ीय एकता
अÁÂ और मजबूत है। यह केवल एक नारा ही नह² है ब³´ भारतीय जीवन दशtन का मूल है। यह केवल स�§ृhतक hवशेषता नह², ब³´ एक ऐसी hवरासत है �जसे पीढ़g दर पीढ़g आगे
बढ़ाया गया है। 'hवhवधता मx एकता' का भाव हमx �सखाता है िक मतभेद होने के बावजूद हम hमलकर रह सकते ह । भारत इस�लए महान है �mिक यह� हर ¯भÄता मx भी अपनापन है ।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 '' अनेक ताअनेक ता   मxमx   एक ताएक ता -- ~हÈ~हÈ   क¦क¦   hवशेष ताhवशेष ता '  '  भा र तभा र त   केके   �लए�लए   ऐसाऐसा   �m�m   क हाक हा   जा ताजा ता   हैहै ??
A nsA ns 1. जाhत, धमt, सं§ृhत और भाषा क¦ hवhवधता हेतु

2 . सामा�जक सौहादt  हेतु
3. धाhमtक सौहादt  हेतु
4. भौगो�लक hव«ार हेतु

Q .61Q .61 Whic h device is  c ommonly  us ed to  c onnec t  a  L A N to  a  WA N?Whic h device is  c ommonly  us ed to  c onnec t  a  L A N to  a  WA N?
A nsA ns 1. Modem

2. Switch
3. Router
4. Hub

Q .62Q .62 What is  a  blog pr imar i ly  us ed for?What is  a  blog pr imar i ly  us ed for?
A nsA ns 1. Sending instant messages

2. Hosting web servers
3. Online shopping
4. Writing and sharing personal or professional content

Q .63Q .63 In M S - E xcel  2 0 1 6 ,  to  c hange the c o lumn width or  row height ,  one mus t go to  _____ .In M S - E xcel  2 0 1 6 ,  to  c hange the c o lumn width or  row height ,  one mus t go to  _____ .
A nsA ns 1. Insert -> Cells -> Format

2. File -> Cells -> Format
3. Design -> Cells -> Format
4. Home -> Cells -> Format

Section : Basic Knowledge of Computer
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Q .64Q .64 Whic h of the fo l lowing c ountr ies  offers  an e- tour is t  v is a to  Indian c it izens?Whic h of the fo l lowing c ountr ies  offers  an e- tour is t  v is a to  Indian c it izens?
A nsA ns 1. Singapore

2. South Africa
3. China
4. The US

Q .65Q .65
A nsA ns 1. 

2. 
3. 
4. 

Q .66Q .66 Whic h of the fo l lowing paths  c orrec t ly  repres ents  the hierarc hic al  s truc ture of d irec tor ies  in Windows?Whic h of the fo l lowing paths  c orrec t ly  repres ents  the hierarc hic al  s truc ture of d irec tor ies  in Windows?
A nsA ns 1. Documents\C:\Users\MyFile.txt

2. C:\Documents\Users\MyFile.txt
3. C:\Users\Documents\MyFile.txt
4. Users\C:\Documents\MyFile.txt

Q .67Q .67 Whic h of the fo l lowing is  a  ty pe of Wide A rea Network  ( WA N) ?Whic h of the fo l lowing is  a  ty pe of Wide A rea Network  ( WA N) ?
A nsA ns 1. Voice over LTE (VoLTE) WAN

2. Adhoc WAN
3. Cloud-managed WAN
4. Internet WAN

Q .68Q .68 You are work ing with a  datas et  in M S  E xcel  that  c ontains  c o lumns  'Produc t ' ,  'Units  S o ld ' ,  'Unit  Pr ice'  and 'D is c ount Rate' .  You needYou are work ing with a  datas et  in M S  E xcel  that  c ontains  c o lumns  'Produc t ' ,  'Units  S o ld ' ,  'Unit  Pr ice'  and 'D is c ount Rate' .  You need
to c alc ulate the total  revenue for  eac h produc t after  apply ing the d is c ount .  The total  revenue is  c alc ulated as  ( Units  S old)  ×  ( Unitto  c alc ulate the total  revenue for  eac h produc t after  apply ing the d is c ount .  The total  revenue is  c alc ulated as  ( Units  S old)  ×  ( Unit
Pr ice)  ×  ( 1  – D is c ount Rate) .  Whic h of the fo l lowing formulas  c orrec t ly  c alc ulates  the total  revenue for  a  produc t  in cel l  E 2  i f  'UnitsPr ice)  ×  ( 1  – D is c ount Rate) .  Whic h of the fo l lowing formulas  c orrec t ly  c alc ulates  the total  revenue for  a  produc t  in cel l  E 2  i f  'Units
S old '  is  in cel l  B2 ,  'Unit  Pr ice'  is  in cel l  C 2  and 'D is c ount Rate'  is  in cel l  D2 ?S old '  is  in cel l  B2 ,  'Unit  Pr ice'  is  in cel l  C 2  and 'D is c ount Rate'  is  in cel l  D2 ?

A nsA ns 1. =(B2+C2)*(1-D2)
2. =B2*C2*(1+D2)
3. =B2*C2-D2
4. =B2*C2*(1-D2)

Q .69Q .69 How c an a us er  add a new s l ide to  their  M S  PowerPoint  pres entat ion?How c an a us er  add a new s l ide to  their  M S  PowerPoint  pres entat ion?
A nsA ns 1. Click 'Design > Add Slide'

2. Click 'View > New Slide'
3. Click 'Animations > New Slide'
4. Click 'Insert > New Slide'

Q .70Q .70 In M ic ros oft  Word ,  what is  the s hortc ut key  to  s ave a  doc ument?In M ic ros oft  Word ,  what is  the s hortc ut key  to  s ave a  doc ument?
A nsA ns 1. Ctrl+X

2. Ctrl+S
3. Ctrl+C
4. Ctrl+V

Q .71Q .71 Whic h of the fo l lowing key board s hortc uts  is  us ed to  ' s ave as '  a  s preads heet in M S - E xcel?Whic h of the fo l lowing key board s hortc uts  is  us ed to  ' s ave as '  a  s preads heet in M S - E xcel?
A nsA ns 1. Alt + T

2. F1
3. F12
4. Ctrl + S

Q .72Q .72 Whic h method provides  the bes t  protec t ion agains t  zero- day  vulnerabi l it ies  on a PC ?Whic h method provides  the bes t  protec t ion agains t  zero- day  vulnerabi l it ies  on a PC ?
A nsA ns 1. Running software in the sandbox mode

2. Using an outdated antivirus
3. Disabling automatic updates
4. Relying solely on firewall protection
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Q .73Q .73 Whic h tab is  us ed to  c hange the paragraph al ignment in M S  Word?Whic h tab is  us ed to  c hange the paragraph al ignment in M S  Word?
A nsA ns 1. Insert Tab

2. Home Tab
3. Reference Tab
4. Review Tab

Q .74Q .74 Whic h of the fo l lowing is  the c orrec t  way  to  c reate a  blank  pres entat ion in M S  PowerPoint?Whic h of the fo l lowing is  the c orrec t  way  to  c reate a  blank  pres entat ion in M S  PowerPoint?
A nsA ns 1. Design tab > New Slide > Blank Layout

2. File tab > New > Blank Presentation > Create
3. Home tab > New > Blank Presentation > OK
4. Insert tab > Slide > New Blank Presentation

Q .75Q .75 Whic h C  l ibrary  d id  G oogle develop s pec ific al ly  for  A ndroid ,  opt imis ed for  mobi le devices?Whic h C  l ibrary  d id  G oogle develop s pec ific al ly  for  A ndroid ,  opt imis ed for  mobi le devices?
A nsA ns 1. Android C Library

2. GNU C Library
3. glibc
4. Bionic

Q .76Q .76 Whic h of the fo l lowing key board s hortc uts  is  us ed to  open a new doc ument in M S  Word?Whic h of the fo l lowing key board s hortc uts  is  us ed to  open a new doc ument in M S  Word?
A nsA ns 1. Ctrl + N

2. Ctrl + W
3. Ctrl + Z
4. Ctrl + O

Q .77Q .77
A nsA ns 1. 

2. 
3. 
4. 

Q .78Q .78
A nsA ns 1. 

2. 
3. 
4. 

Q .79Q .79 Whic h of the fo l lowing options ,  avai lable in the Windows  1 0  operat ing s y s tem's  C ontrol  Panel ,  helps  c hange the bas ic  propert ies  ofWhic h of the fo l lowing options ,  avai lable in the Windows  1 0  operat ing s y s tem's  C ontrol  Panel ,  helps  c hange the bas ic  propert ies  of
a mous e device,  s uc h as  to  c hange the mous e pointers  and button c onfigurat ion?a mous e device,  s uc h as  to  c hange the mous e pointers  and button c onfigurat ion?

A nsA ns 1. Add a device option under Hardware and Sound category
2. Adjust commonly used keyboard, mouse and mobility settings option under Hardware and Sound category
3. Mouse settings option under View devices and printers / Ease of Access category
4. Mouse Properties option under Appearance and Personalization category

Q .80Q .80 In G oogle C hrome,  to  pr int  a  web page,  we have to  c l ic k  on the Pr int  button avai lable under  the 'C us tomize and c ontro l  G oogleIn G oogle C hrome,  to  pr int  a  web page,  we have to  c l ic k  on the Pr int  button avai lable under  the 'C us tomize and c ontro l  G oogle
C hrome'  opt ion avai lable at  the top- r ight c orner  of the web page.  To  make addit ional  c hanges  in the s ett ings ,  we need to  c l ic k  onC hrome'  opt ion avai lable at  the top- r ight c orner  of the web page.  To  make addit ional  c hanges  in the s ett ings ,  we need to  c l ic k  on
the _________ button in the Pr int  d ia log box opened .the _________ button in the Pr int  d ia log box opened .

A nsA ns 1. Save As
2. More Settings
3. Print
4. Open

Q .81Q .81 The average of the marks  of 1 5 s tudents  in a  c las s  is  4 5.  I f  the marks  of eac h s tudent are doubled ,  find the new average.The average of the marks  of 1 5 s tudents  in a  c las s  is  4 5.  I f  the marks  of eac h s tudent are doubled ,  find the new average.
A nsA ns 1. 15

2. 45
3. 90
4. 30

Section : Quantitative Aptitude
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Q .82Q .82 The s el l ing pr ice of 50  books  is  equal  to  the c os t  pr ice of 24  books .  F ind the los s  or  gain percentage.The s el l ing pr ice of 50  books  is  equal  to  the c os t  pr ice of 24  books .  F ind the los s  or  gain percentage.
A nsA ns 1. 

2. 

3. 

4. 

Q .83Q .83
A nsA ns 1. 

2. 

3. 

4. 

Q .84Q .84 A  number is  firs t  dec reas ed by  2 0 % and then inc reas ed by  2 0 %.  The number s o  obtained is  64  les s  than the or iginal  number.  WhatA  number is  firs t  dec reas ed by  2 0 % and then inc reas ed by  2 0 %.  The number s o  obtained is  64  les s  than the or iginal  number.  What
was  the or iginal  number?was  the or iginal  number?

A nsA ns 1. 1600
2. 1800
3. 2100
4. 2000

Q .85Q .85 3  t imes  the pres ent age of L at ika is  1 7  y ears  more than 2  t imes  the pres ent age of S has hank ,  and 8  t imes  the pres ent age of3  t imes  the pres ent age of L at ika is  1 7  y ears  more than 2  t imes  the pres ent age of S has hank ,  and 8  t imes  the pres ent age of
S has hank  is  1 7  y ears  les s  than 9 t imes  the pres ent age of L at ika .  The s um of the pres ent ages  ( in y ears)  of  L at ika and S has hank  is :S has hank  is  1 7  y ears  les s  than 9 t imes  the pres ent age of L at ika .  The s um of the pres ent ages  ( in y ears)  of  L at ika and S has hank  is :

A nsA ns 1. 35
2. 32
3. 34
4. 30

Q .86Q .86 3 0  kg of wheat ,  whic h c os ts  ₹4 5 per  kg,  is  mixed with 1 5 kg of another  ty pe of wheat to  get  a  mixture that  c os ts  ₹50  per  kg.  F ind3 0  kg of wheat ,  whic h c os ts  ₹4 5 per  kg,  is  mixed with 1 5 kg of another  ty pe of wheat to  get  a  mixture that  c os ts  ₹50  per  kg.  F ind
the pr ice ( in ₹)  per  kg of the c os t l ier  wheat .the pr ice ( in ₹)  per  kg of the c os t l ier  wheat .

A nsA ns 1. 45
2. 50
3. 60
4. 55

Q .87Q .87

A nsA ns 1. 
2. 
3. 
4. 

Q .88Q .88 O ver  the pas t  1 0  y ears ,  the populat ion of a  town has  inc reas ed by  2 0 %.  The populat ion of the town 1 0  y ears  ago was  2 5,0 0 0 .  WhatO ver  the pas t  1 0  y ears ,  the populat ion of a  town has  inc reas ed by  2 0 %.  The populat ion of the town 1 0  y ears  ago was  2 5,0 0 0 .  What
is  the populat ion of the town now?is  the populat ion of the town now?

A nsA ns 1. 30,000
2. 31,000
3. 29,000
4. 34,000

Q .89Q .89 Two trains  of lengths  1 60  m and 90  m are running in the s ame d irec t ion with s peeds  of 4 0  km/ h and 50  km/ h,  res pec t ively .  TheTwo trains  of lengths  1 60  m and 90  m are running in the s ame d irec t ion with s peeds  of 4 0  km/ h and 50  km/ h,  res pec t ively .  The
time taken by  them to  c ros s  eac h other  is :t ime taken by  them to  c ros s  eac h other  is :

A nsA ns 1. 95 sec
2. 90 sec
3. 80 sec
4. 75 sec
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Q .90Q .90 The pres ent ages  of M  and N are in the rat io  of  4  :  5,  res pec t ively .  Three y ears  ago ,  the rat io  of  their  ages  was  7  :  9 ,  res pec t ively .The pres ent ages  of M  and N are in the rat io  of  4  :  5,  res pec t ively .  Three y ears  ago ,  the rat io  of  their  ages  was  7  :  9 ,  res pec t ively .
How o ld  ( in y ears)  is  M  at  pres ent?How old  ( in y ears)  is  M  at  pres ent?

A nsA ns 1. 28
2. 30
3. 24
4. 20

Q .91Q .91
A nsA ns 1. −137

2. −153
3. −147
4. −155

Q .92Q .92

A nsA ns 1. 

2. 

3. 

4. 

Q .93Q .93
A nsA ns 1. −428

2. −422
3. −434
4. −424

Q .94Q .94 A  pers on s aves  60 % of his  inc ome.  I f  his  expenditure is  ₹560 ,  then his  inc ome ( in ₹)  is :A  pers on s aves  60 % of his  inc ome.  I f  his  expenditure is  ₹560 ,  then his  inc ome ( in ₹)  is :
A nsA ns 1. 700

2. 1,440
3. 1,400
4. 840

QQ
..
99
55
AA
nn
ss

1. 

2. 
3. 
4. 

Q .96Q .96 A  dealer  s o ld  his  goods  at  a  d is c ount of 2 0 % but s et  the marked pr ice of eac h art ic le at  3 0 % above the c os t  pr ice.  H is  gainA  dealer  s o ld  his  goods  at  a  d is c ount of 2 0 % but s et  the marked pr ice of eac h art ic le at  3 0 % above the c os t  pr ice.  H is  gain
percentage on eac h art ic le is  _________ .percentage on eac h art ic le is  _________ .

A nsA ns 1. 8%
2. 10%
3. 4%
4. 5%

Q .97Q .97 A  train runs  at  the s peed of 80  km/ h.  Find the d is tance c overed by  the train in 1 2  minutes  ( in km) .A  train runs  at  the s peed of 80  km/ h.  Find the d is tance c overed by  the train in 1 2  minutes  ( in km) .
A nsA ns 1. 12

2. 10 
3. 14
4. 16

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .98Q .98 The c os t  pr ice of 6  art ic les  is  equal  to  the s el l ing pr ice of 1 0  art ic les .  F ind the gain or  los s  percentage.The c os t  pr ice of 6  art ic les  is  equal  to  the s el l ing pr ice of 1 0  art ic les .  F ind the gain or  los s  percentage.
A nsA ns 1. 60% gain

2. 60% loss
3. 40% gain
4. 40% loss

Q .99Q .99 A ,  B,  and C  c an c omplete a  piece of work  indiv idual ly  in 24  day s ,  3 0  day s ,  and 4 0  day s ,  res pec t ively .  I f  they  a l l  s tart  the workA ,  B,  and C  c an c omplete a  piece of work  indiv idual ly  in 24  day s ,  3 0  day s ,  and 4 0  day s ,  res pec t ively .  I f  they  a l l  s tart  the work
together,  in how many  day s  wi l l  they  c omplete half  of  the total  work?together,  in how many  day s  wi l l  they  c omplete half  of  the total  work?

A nsA ns 1. 5 days
2. 6 days
3. 4 days
4. 8 days

Q .1 0 0Q .1 0 0

A nsA ns 1. 3250
2. 2250
3. 3300
4. 3000

https://applink.adda247.com/d/XhqWf9lSap
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